Release notes - IBM SPSS Data Collection
Desktop 6 Patch 1
IBM® SPSS® Data Collection Desktop 6 Patch 1 is available. Compatibility, installation, and
other getting-started issues are addressed.
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Description
IBM SPSS Data Collection Desktop 6 provides a suite of desktop applications that support the
creation, authoring, and editing of surveys that are used for conducting phone interviews, web
interviews, and face-to-face interviews. IBM SPSS Data Collection Desktop 6 Patch 1
updates the following products:













IBM SPSS Data Collection Author Desktop Edition — used for creating and
previewing surveys for use in a variety of output formats. When you have created your
survey, you can activate it to an Interviewer Server or open it in Paper to format it and
add scanning control information.
IBM SPSS Data Collection Survey Reporter Desktop Edition — a survey and
market research analysis tool that provides options for creating tables and analyzing
the data collected from surveys.
IBM SPSS Data Collection Base Professional — offers a complete set of tools that
supports the building of automated market research processes. Base Professional
includes an integrated development environment (IDE) that enables you to create, edit,
run, and debug Data Collection scripts. In addition, Professional comes with the
internal components that enable you to create scripts that perform various data
management tasks.
IBM SPSS Data Collection Data Model — acts as a data access framework that sits
between applications and data stored in various formats or database schemas. You can
consider the Data Model to be an interpreting or translation service that enables an
application to understand the data. This capacity of the Data Model, together with its
open architecture, removes the data storage and access restrictions of older,
proprietary architectures.
IBM SPSS Data Collection Interviewer — a fully integrated interviewing solution
for mobile and on-site data collection. Using Interviewer, you can conduct operations
using automated data synchronization via server or manual data transfers in a nonserver environment.
IBM SPSS Translation Utility — provides a simple, efficient method for translating
text contained in Data Collection questionnaires and other forms.
IBM SPSS Data Collection Paper — provides a comprehensive solution for
formatting paper questionnaires for scanning and keyboard data entry. Paper can





format paper questionnaires quickly and easily, taking full advantage of the features of
Microsoft Word.
IBM SPSS Data Collection Paper — Scan Add-on — like Paper, is an add-in to
Microsoft Word and extends the functionality of Paper for studies in which you want
to scan the completed questionnaires.
IBM SPSS Data Collection Developer Library (DDL) — an information-rich
resource for anyone learning about and working with Data Collection products. The
DDL comes with a number of samples, including scripts, tools, example data, and
source code.

New features
IBM SPSS Data Collection Desktop 6 Patch 1 provides the following new features:


Updated role-based security — New application features were added in patch 1. As
a result, the Activation and Author application features have been grouped in
Interviewer Server Administration based on their function. Refer to the Default IBM
SPSS Data Collection Author roles and activities topic in the IBM SPSS Data
Collection Author User's Guide for more information.

Refer to Readme.txt in the root installation directory for information pertaining to the IBM
SPSS Data Collection license agreement.

Compatibility issues with earlier versions
Patch 1
Author role-based access
IBM SPSS Data Collection Desktop 6 Patch 1 provides new activity features to support rolebased access to the Author application. Role-based access allows you to customize and
manage permissible tasks assigned to Author users. Role-based limitations restrict users from
viewing, editing, and adding components in a survey without the proper privileges. Rolebased access applies to both the desktop and web-deployed versions of Author when the
application accesses projects that are located in IBM SPSS Data Collection Interviewer Server
Administration.
The new activity features require an Interviewer Server Administration administrator to
manually add the features to the appropriate users and roles. Refer to the Default IBM SPSS
Data Collection Author roles and activities topic in the IBM SPSS Data Collection Author
User's Guide for more information.

Version 6 GA
Data Entry



The Data Entry Player user interface has been improved and no longer supports
HTML tags and formatting.
Keyboard shortcuts for various functions have been reduced from multi-stroke actions
to single-stroke actions.



Only on-path responses (those keyed by an operator) are displayed in the historical
response list.

Documentation
IBM SPSS Data Collection Desktop 6 Patch 1 installs updated documentation files. The
updated information may not correctly display in the help system until you manually delete
the IBM Eclipse Help System's cache files:
1. Navigate to the Windows Control Panel > Administrative Tools > Services and stop
the DataCollectionHelpCenterService service.
2. Go to C:\Program Files\Common
Files\IBM\SPSS\DataCollection\6\Documentation\ibm_help\eclipse and delete the
workspace directory.
3. Open the configuration directory and delete the four child directories
(org.eclipse.core.runtime, org.eclipse.equinox.app, org.eclipse.osgi, and
org.eclipse.update). Take care that you DO NOT delete the file config.ini.
4. Restart the DataCollectionHelpCenterService service. All of the help system topics
should now display as expected.

System requirements and installation
When you run the IBM SPSS Data Collection Desktop 6 Patch 1 installer on your machine, it
will verify which applications are installed, and install only the required files for the
applications currently installed. If no applications are installed, you must first install the
appropriate applications from the IBM SPSS Data Collection Desktop 6 installation CD.
Important:




Ensure that you backup all customizable files prior to installing the patch. For
example, many of the application configuration files can be customized to meet your
business requirements. The patch will overwrite these files.
Ensure all applications are closed before starting the patch installation. The IBM SPSS
Data Collection Desktop 6 Patch 1 installer may initiate a system reboot to complete
the installation procedure.

Caution:
Do not attempt to install IBM SPSS Data Collection Desktop 6 Patch 1 over the following
products:


Release 5.6 or earlier Data Collection products.

Installing the patch
Copy the IBM SPSS Data Collection Desktop 6.00.010.exe file to your computer, and double
click the file. You will need to have administrative privileges, and if you installed the
products using a specific user, you should log on to the machine as that user to install the
patch.

Uninstalling the patch
You cannot use the Windows Control Panel > Add or Remove Programs feature to uninstall
the patch. If you need to uninstall the patched applications, you can do so by running the
patch executable file.

Notes







IBM SPSS Data Collection does not support products patched at different levels.
When the patch installer prompts you to select which products to upgrade, any
products currently installed on your system are selected by default. If you elect not to
patch a product installed on your system, the patch installer removes that product.
When you install the patch, it will add an entry to the Windows Control Panel > Add
or Remove Programs list, indicating that it is present.
If Windows automatically repairs an IBM SPSS Data Collection Desktop 6 product
after the patch has been installed, you will need to uninstall and install the patch again
in order to restore the patched files for the repaired product. A repair will typically
occur only after one or more product files have been deleted. When a repair takes
place, the product installation dialog may appear after you start an IBM SPSS Data
Collection Desktop product, and details of the repair may also be logged in the
Windows event log.
If you uninstall the patch, it will delete all the new files that it installed but it cannot
restore the original versions of files that it updated. Therefore, uninstalling the patch
can result in IBM SPSS Data Collection Desktop products that do not work correctly.

For information on system requirements, see the IBM SPSS Data Collection Desktop 6
Installation Guide. The guide is located on the IBM SPSS Data Collection Desktop 6 CD at:
CD:/Documentation/<language>/Server_Installation_Guide.pdf

Known problems
At time of publication, the following issues were known:

Installation


The installation program verifies the required prerequisites out-of-order.
For more information, refer to ClearQuest defect # ECM00147996.

Author Desktop Edition
Note: Most of the known problems in this section also apply to Author Server Edition
Questions pane


The display order of items in the Question pane design view can change when
questions are placed into a section.
For more information, refer to ClearQuest defect # ECM00028791.

Shared Lists pane


The context menu is missing for shared lists in the Shared Lists pane.
For more information, refer to ClearQuest defect # ECM00029383.



If the name of the shared list is the same as one of its responses' names, the shared list
cannot be attached to a question.
For more information, refer to ClearQuest defect # ECM00071286.

Question Repository


The Question Repository features are only applicable when the IBM SPSS
Collaboration and Deployment Services - Server Adapter for Data Collection is
installed on the appropriate IBM SPSS Collaboration and Deployment Services server.
Refer to the topic “IBM SPSS Collaboration and Deployment Services - Server
Adapter” in the Data Collection Developer Library for more information.



When inserting a question item with multiple routings, only the first routing is
inserted.
For more information, refer to ClearQuest defect # ECM00029452.



A misleading “not authorized” error message is displayed when you fail to access a
repository due to a problem with its configuration.
For more information, refer to ClearQuest defect # ECM00103674.



Question icons in the Routing or Question panes do not match the icons in the Insert
Questions drop-down box.
For more information, refer to ClearQuest defect # ECM00141755.

General issues


After modifying a routing name, section name, or page name, you cannot undo/redo
the modification.
For more information, refer to ClearQuest defect # ECM00071419.



It is not possible to base an If..Goto on special responses.
For more information, refer to ClearQuest defect # ECM00052020.



A CATI routing activated through Author can change the question order when
imported into Interviewer Server - mrInterview.
For more information, refer to ClearQuest defect # ECM00029392.



Validating a document does not catch duplicate label declarations. This can cause
Interview Preview and Activate to Interviewer Server - mrInterview to fail.
For more information, refer to ClearQuest defect # ECM00052022.



It is not currently possible to use numeric grids for If..Goto items.
For more information, refer to ClearQuest defect # ECM00052024.



When performing an Edit | Replace, all instances are replaced, instead of prompting to
replace each found instance.
For more information, refer to ClearQuest defect # ECM00029402.



The Questions pane is not correctly updated when copying questions between Author
instances.
For more information, refer to ClearQuest defect # ECM00052241.



Cannot display the correct page after using the script "LoopName.Ask()" in the
Routing Section.
For more information, refer to ClearQuest defect # ECM00030673.

Survey Reporter Desktop Edition
Note: Most of the known problems in this section also apply to the Survey Reporter Server
Edition


You will occasionally encounter an error when populating results using "Sort by
Column Significance."
For more information, refer to ClearQuest defect # ECM00029492.



You cannot change a variable name, and then change the name back to its original
value.
For more information, refer to ClearQuest defect # ECM00029499.



When running table results from a .pkd file, Survey Reporter ignores calculations done
with the Keep and OP= options applied in Quantum.
For more information, refer to ClearQuest defect # ECM00103423.

Base Professional


The Data Link Properties dialog box sometimes creates the “mrOleDB.Provider.2”
Provider connection property without the trailing ".2". When using the Data Link
Properties dialog box to select data sources and generate a connection string, either by
double-clicking on a .udl file, or from within WinDMSRun, the Provider connection



property may sometimes be created as mrOleDB.Provider instead of
mrOleDB.Provider.2. However, this does not appear to lead to any problems.
Working with IBM SPSS Statistics .sav files. Base Professional provides only limited
support for running multiple exports to the same .sav file and for .sav files that contain
Japanese characters.
For further information, please refer to the topics entitled “Transferring Data From
SPSS” and “Transferring Data To SPSS” in the Professional Data Management
Scripting section of the Data Collection Developer Library.



The HTML Tidy feature in Base Professional moves mrRef tags from the head to the
body of the template.
For more information, refer to ClearQuest defect # ECM00026436.



Routing contexts created in Author do not save to .IVS files.
For more information, refer to ClearQuest defect # ECM00150104.

Data Model


The Quantum DSC does not recognize { as a valid punch character.
For more information, refer to ClearQuest defect # ECM00025717.



It is not possible to call web-service methods via the MSSoapClient from
mrScriptBasic.
For more information, refer to ClearQuest defect # ECM00150207.



There is currently no support for unbounded level variables that exist under bounded
level variables.
For more information, refer to ClearQuest defect # ECM00135726.

Interviewer
None at this time.

Translation Utility
None at this time.

Paper and Paper — Scan Add-on


Problem starting certain versions of Word 2003. If you are running Word 2003
with no service pack, or a service pack earlier than Service Pack 2 applied, you may
encounter the following problem when attempting to start Word: "Word cannot open
this document template (C:\Document and Settings\...\mrScan.dot)".

To solve this problem, please install Office 2003 Service Pack 2, obtainable from
Microsoft.


Using Word XP with Paper. If you have Word XP and want to use it with Paper, it is
advisable to uninstall Word 97 or Word 2000 before installing Word XP. It has been
noticed that upgrades to Word XP without uninstalling earlier versions can cause some
Word options to change. Depending on which options change, this may affect the
validity of the questionnaires that you create with Paper. For example, the Hidden
Text option is normally switched off so that scanning information is not visible when
you display the questionnaire. If this option is switched on by the upgrade to Word
XP, then any questionnaires that you create will contain incorrect scanning definitions
until you switch the option off again. If you use Word XP with its default settings, you
will see additional information displayed at the end of some of the character styles in
the drop-down list of style names. For example, the Paper style mr Question Short
Name will be displayed as mr Question Short Name + Bold, and mr Category Is Go
To will be mr Category Is Go To +7pt.
To change the default settings so that just the basic style names are shown, choose
Format > Styles > Formatting and then select Custom Configuration.



Scanning illegal responses. The Illegal Value option for Mark Fields in Paper —
Scan Add-on allows you to replace invalid responses with a response code of your
choice. However, because this value does not appear as a valid code in the
questionnaire definition (.mdd) file the DSCs cannot export it to the output datasource.
We therefore recommend that you do not use this option if exporting using Paper —
Scan Add-on Transfer. Instead, use the Allow Illegal responses option to accept the
data as it appears on the questionnaire and then clean the output data source before
analyzing the data.
Refer to the Paper — Scan Add-on User’s Guide help file for information about the
Allow Illegal responses option.





Effect on Paper and Microsoft Outlook of using Word as your e-mail editor. If
you use Microsoft Word as your e-mail editor, and you have Outlook and Paper
running at the same time, the two applications share the same instance of Word rather
than each having their own instance. This may affect the way Paper and Outlook
behave in certain circumstances:
o When you open a questionnaire in Paper, the questionnaire is locked to prevent
other users trying to change it at the same time. Paper unlocks the file when
you close it. However, if you use Microsoft Outlook with Word as your e-mail
editor, and you leave Outlook running in the background, any questionnaires
that you open with Paper will remain locked until you close Outlook. This is
because Outlook keeps Word alive all the time that Outlook is running, even
though you may not be editing a message at the time.
o If an Paper dialog box is open while you are editing a message, any keystrokes
you make while editing the message are ignored. This is because the Paper
dialog box has control of the keyboard. To be able to edit the message you
must close the Paper dialog box.
Alignment of questions in compound grids of fewer than five questions. In
compound grids of fewer than five questions it may occasionally look as if the
columns in a compound grid are misaligned. If you view the questionnaire in Print



Preview mode you will usually see that the misalignment is not visible, and will not
affect the printed questionnaire.
Uneven column widths in compound grids. When a questionnaire contains a
compound grid, Paper generates a table for each question in the grid separately and
makes all columns in a particular table the same width. It then joins the tables to form
a single table and adjusts the column widths so that the compound grid fits into the
available page width with the columns evenly distributed across the grid. (Word’s
AutoFit option for tables is turned off so that all table formatting is controlled by
Paper.) Finally, Paper inserts an mrSeparator item after the grid. Most of the time this
process works as intended. Occasionally, however, the insertion of the mrSeparator
item causes the column widths to change so that the columns are no longer evenly
distributed. Detailed investigations of this feature prove that Paper is working
correctly and that the problem is caused by Word itself. Unfortunately, we have so far
been unable to identify what causes Word to behave in this manner.
For the time being, if you encounter this problem you will have to set the column
widths manually.



Misaligned fields in EHF Manager. When you view questionnaires in EHF Manager
you may sometimes see fields that are slightly misaligned on certain machines but not
on others. With ‘comb’ fields for numeric responses, for example, you may see that
the start or end bar of the ‘comb’ is missing. Tests have shown that the exact cause of
the problem varies across operating systems and machine configurations, and is
usually related to the way the individual machines have been configured.
If you think you have encountered this problem, contact your Support Representative
for assistance.



‘Comb’ Boxes for numeric fields in scanned questionnaires. Tests have shown that
using ‘comb’ boxes for numeric fields can sometimes result in incorrect data from
scanned questionnaires. This is because EHF sometimes interprets part of the ‘comb’
as data so that, for example, the number 4 is interpreted as 14. The problem is
intermittent and inconsistent. Rescanning a questionnaire often results in the problem
disappearing altogether or in a different numeric question being scanned incorrectly.
If you encounter this problem, contact your Support Representative for assistance.





Working with non-western languages. In Paper, there are a number of limitations to
the display of characters in languages that are not supported by the default code page
selected on your computer. (A code page is a table of the binary character codes used
by computer programs and the characters that they represent. You select the default
code page under Language Settings in the Regional Settings of the Control Panel.) For
example, when you have the Western Europe and United States code page selected as
your default code page, you can use and display all of the characters used in Western
European languages. However, Paper will not always display Japanese characters
correctly, even when you have Japanese installed on your computer.
Language codes. Paper can recognize a language only if the standard three-character
code is used for the language in the questionnaire definition.

For information about the standard three-character language codes, see Microsoft's
Global Development reference topic:
http://www.microsoft.com/globaldev/reference/winxp/langtla.mspx.


Questionnaire definition files exported from In2Form do not display the correct
information for ranges in the respondent serial number and open-ended text fields. For
the respondent serial number, the text displayed is ‘Write in answer 1’. For an openended question whose max value is set to 35, Paper displays ‘Write in answer:35’
instead of ‘Write in answer. Maximum number of characters:35’. This problem is
related to the problem with exporting Quantum data from In2Form questionnaire
definition files (see Quantum Data from In2Form and Quanquest 2.4 Questionnaires
above) and can be corrected by running mdm2quantum on the .mdd file before
opening it in Paper.
For more information, refer to ClearQuest defect # ECM00073922 .



Text, diagrams or images added to a template to go at the end of the questionnaire do
not appear at the end of the questionnaire. Instead, Paper inserts them within
mrSeparator tags at various points throughout the questionnaire. A work-around for
this problem is to add an AutoText entry to the template containing the closing matter
and then to insert the AutoText entry manually at the end of each questionnaire that
you create with that template. To create an AutoText entry, type the text you want to
use and/or insert the images in a document that uses the template. Highlight the text
and/or images and press ALT+F3. When prompted, enter a label for the AutoText
entry that describes its purpose (for example, ClosingTextHere). To insert the closing
matter in a questionnaire, type its label name at the point you want the closing matter
to appear and press F3 to replace the label name with the text and/or images it
represents.
For more information, refer to ClearQuest defect # ECM00075257.



A problem in Microsoft Office 2000 and Office XP can cause tick boxes in grids to be
misaligned near adjustment or recognition fields when scanning fields are inserted in a
questionnaire. The misalignment is most visible when the mr Grid Subquestion text
field contains long texts. Although the text alignment of the cells is set correctly as
center-bottom, the tick box appears at center-top. A solution to this problem is to
create a Look with a wider grid subquestion text area and to apply this Look to the
affected questions. Although this will not solve the misalignment problem completely,
it will reduce the number of rows required for the subquestion text and so reduce the
row height so that the misalignment is less obvious. Other suggestions that may be of
use are as follows:
o If the grid spans more than one page, divide it into a number of smaller grids
each of which fits onto a single page. This ensures that the grid column
headings appear at the top of the page rather than the page starting with a row
of tick boxes, and this appears to prevent the misalignment happening. Note:
We do not recommend grids that span more than one page because this can
affect the naming of variables in EHF.
o Move recognition fields from the right of the page to the bottom of the page.
o Change the adjustment fields so that there are none on the right of the grid.
For more information, refer to ClearQuest defect # ECM00075283.



Transfer fails with application errors in ReadSoft DOCUMENTS for FORMS 5.3
Patch 1.
For more information, refer to ClearQuest defect # ECM00137177.



At this time, Readsoft DOCUMENTS for Forms 5.3 does not support Microsoft
Windows 7 or Microsoft Windows Server 2008 (x64bit).
For more information, refer to ClearQuest defect # ECM00138307.

Data Collection Developer Library


You may experience missing help topics when the Data Collection Developer Library
is installed after the Data Collection applications are installed. You can restore the
missing topics by manually deleting the IBM Eclipse Help System’s cache files:
1. Navigate to the Windows Control Panel > Administrative Tools > Services
and stop the DataCollectionHelpCenterService service.
2. Go to C:\Program Files\Common
Files\IBM\SPSS\DataCollection\6\Documentation\ibm_help\eclipse and delete
the workspace directory.
3. Open the configuration directory and delete the four child directories
(org.eclipse.core.runtime, org.eclipse.equinox.app, org.eclipse.osgi, and
org.eclipse.update). Take care that you DO NOT delete the file config.ini.
4. Restart the DataCollectionHelpCenterService service.
All of the help system topics should now display as expected.
For more information, refer to ClearQuest defect # ECM00144484.

Related information
Technical Support is available to maintenance customers. Customers may contact Technical
Support for assistance in using products or for installation help for one of the supported
hardware environments. To reach Technical Support, see the SPSS web site at
http://support.spss.com.
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